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Cos’è la cartografia digitale

• Gli obiettivi della cartografia digitale non si differenziano
da quelli della cartografia classica

• Registrare la posizione sul territorio di oggetti o punti
• Rappresentare le caratteristiche morfologiche del territorio
• Rappresentare percorsi di spostamento
• Associare proprietà e caratteristiche ad oggetti
• Rappresentare territori immaginari, o proiettati nel passato,

o nel futuro
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A cosa serve la cartografia digitale

• Anche l’uso della cartografia digitale non si allontanano da
quelli della cartografia classica

• Calcolare dimensioni geometriche relative ad oggetti ed
aree

• Determinare e registrare confini di stati e proprietà
• Determinare rotte per raggiungere destinazioni
• Documentare viaggi e altri generi di spostamento
• Collocare geograficamente eventi umani o naturali

Mappe e dintorni: esploriamo la cartografia digitale

I vantaggi della cartografia digitale

• La cartografia digitale si differenzia da quella classica per il
supporto sul quale è registrata la mappa

• una memoria digitale, accessibile tramite un dispositivo
adatto

• La cartografia digitale, rispetto alla tradizionale presenta
vantaggi importanti

• dematerializzazione della mappa, che diventa facilmente
condivisibile

• possibilità di acquisizione automatica di posizioni e
spostamenti

• semplicità di manipolazione e creazione
• possibilità di fondere dati provenienti da mappe diverse
• possibilità di collegare alla mappa informazioni

multi-mediali
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Cartografia digitale aperta e chiusa

• Alternativa sempre presente in Internet:
• il contenuto è di dominio pubblico o è privato?

• Si presenta anche nella cartografia
• Cartografia open source: Open Street Map

• Le mappe sono di pubblico dominio
• Chiunque può aggiungere dettagli alle mappe
• Le mappe possono essere riutilizzate

• Cartografia gratuita: Google Maps
• L’accesso alla mappa avviene attraverso un servizio privato
• Chiunque può aggiungere una propria mappa

• Cartografia privata: mapbox
• Le mappe sono cedute a pagamento
• Chi le acquisisce può utilizzarle a pagamento
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La terminologia GIS

• Features (caratteristiche)
• Punti (associati a coordinate)
• Linee (composte da più segmenti)
• Aree (superfici delimitate da linee chiuse)

• Attributi (associati alle features)
• Vettore (rappresentazine di un insieme di features)
• Raster (rappresentazione puntuale di un’area geografica)
• Layers (livelli)
• Canvas (sfondo)
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Gli strumenti per il GIS: i database
• Database specializzati registrano livelli, features e attributi
• Un esempio in Postgis:

INSERT INTO luoghi (name, coord)

VALUES (’Pisa’,ST_GeographyFromText(’SRID=4326;POINT(10.41 43.72)’));

• Legenda:
• luoghi è una table che mi sono creato in precedenza
• ha due colonne che descrivono il nome di un punto e le sue

coordinate
• Con la INSERT inserisco una nuova registrazione
• Il nome del nuovo punto è Pisa
• Le coordinate sono inserite con una funzione specifica di

Postgis: STGeographyFromText
• La stringa di testo contiene un parametro SRID che

identifica il sistema di coordinate
• 4326=WGS84, ce ne è una dozzina

• e l’indicazione di un punto: prima la longitudine, poi la
latitudine
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Esempio di applicazione su server: OpenStreetMaps

• Il server (www.openstreetmap.org) mi presenta l’immagine
che è sul database, tramite il browser

• Lavoro direttamente su dati pubblici: tutti mi vedono!
• Non posso scegliere di lavorare in uno spazio privato
• Se uso l’editor online Id

• Creo facilmente: un bar, una piscina, una strada
• Potrei fare "Save" (ma non lo faccio...)

• Altrimenti tutti vedrebbero!
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Traccia dettagliata di un esercizio
• Creare una feature su OpenStreetMaps

• Aprire il browser sul sito OpenStreetMap
• Accedere al servizio

• utilizzare il proprio account su una delle "terze parti" oppure
• seguire la procedura con il tasto "Registrati" (meglio, per

usare poi uMap)
• Per creare una feature (ma non premere Salva)

• Selezionare il tasto "Modifica" (si accede all’editor online
"Id")

• Premere sul tasto "Punto" (diventa blu)
• Selezionare un punto sulla cartina con un click
• Selezionare la tipologia di punto (ad es. "Caffè")
• Compilare gli elementi interessanti
• Premere "Annulla" (freccia all’indietro, accanto ad Area)

• Per segnare una strada o un perimetro chiuso, un click per
ogni punto, doppio click per concludere

• Premendo Salva la nostra "feature" fasulla verrebbe
registrata nel database di OpenStreet (non fatelo)
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Esempio di applicazione locale: qGis

• Quantum GIS (qGis) è una applicazione GIS Open Source
• il software è mantenuto e sviluppato da volontari
• prima release nel 2002

• Può essere installato su Windows, Linux, MacOS
• In grado di acquisire ed aggregare layers da formati diversi

• sia dati locali che database remoti
• Consente di creare nuovi layers

• anche di commentare le features
• Alla fine posso:

• produrre un file grafico
• salvare in formato qGis
• pubblicare la mappa

• Può fare grandi cose ma non fa nulla per rendersi
simpatico

https://www.openstreetmap.org


Mappe e dintorni: esploriamo la cartografia digitale

Traccia dettagliata di un esercizio
• Aprire qGis e selezionare Progetto->Nuovo
• Installare il Plugin "Openlayers" (se non è già installato)

• Plugins->Gestisci...->cercare OpenLayers Plugin->Installa
plugin

• Selezionare lo sfondo con
• Web->OpenLayers plugin->OpenStreetMap

• Ctrl++ per selezionare aree
• Ripetere l’operazione di selezione

• Creare una serie di punti sulla mappa
• Layer->Nuovo Vettore->Nuovo shapefile->Ok
• Indicare un file dove salvarlo (Demo): compare nella

legenda
• Click (destro) sulla voce Demo nella legenda e Modifica

• compare una matita sull’icona
• Modifica -> Aggiungi elemento
• Spostare il puntatore sulla mappa (visualizza un mirino)
• Click sul punto desiderato sulla mappa ed inserire l’id

(numerico)
• Click su un altro punto eccetera
• Al termine click (destro) sulla voce Demo nella legenda e

Modifica
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Traccia dettagliata di un esercizio

• Modificare la grafica dei punti
• click (destro) sulla voce Demo e selezionare Proprietà
• modificare simbolo grafico o altro
• premere OK

• Aggiungere un attributo (descrizione) ai punti
• selezionare il layer Demo
• Layer->Modifica
• Layer->Apri tabella attributi
• Ctrl+W
• Impostare nome e tipo (Stringa) per l’attributo
• Compilare gli attributi con un doppio click

• Selezionare con doppio click e modificare

• Salvare il progetto
• nel formato proprio di qGis
• come immagine
• in un formato vettoriale abbastanza diffuso (DXF)
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Gli strumenti per il GIS: le librerie JavaScript

• Il JavaScript è il linguaggio utilizzato per incorporare nelle
pagine web funzioni complesse

• La libreria JavaScript Leaflet consente di interagire con
server GIS remoti ed integrare nella pagina i nostri dati e
quelli dei server

• Si realizza una struttura complessa: l’utente che scarica
una certa pagina (realizzata dal cartografo) interagisce
anche con un server SQL esterno e con un database di
raster
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Gli strumenti per il GIS: GIS in the cloud
• Il cartografo può utilizzare anche strumenti cloud per

creare una nuova la mappa
• Con il suo browser il cartografo accede al servizio di

realizzazione di mappe
• Crea la sua pagina web che incorpora la mappa (ad es.

realizzata con leaflet)
• Il codice incorporato nella pagina web si collega al

database remoto e utilizza/registra dati
• La pagina web è visibile (o anche modificabile) da altri

utenti
• e inoltre (i vantaggi del cloud):

• nessuna installazione necessaria
• nessun problema di capacità di calcolo
• non dipende dal sistema operativo
• adattabile a dispositivi diversi (PC o smartphone)

• Sembra complicato, ma è semplicissimo
• L’esempio più noto: Google MyMaps
• Noi esploriamo l’alternativa open source: uMap
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Il servizio uMap

• Progetto recente, datato 2014
• Codice OpenSource (installabile su un server proprio)
• Utilizza i dati di OpenStreetMaps
• Consente di creare una mappa

• utilizzando i dati raster di OSM
• aggiungendo layers vettoriali da altri database
• aggiungendo features definite tramite interfaccia grafica

• Possibile aggiungere note pop up
• Nella nota testo, immagini, link
• La mappa generata è condivisibile in modo selettivo
• Registrazione opportuna ma non indispensabile
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Iniziare con uMap

• Con il browser andare alla URL
http://umap.openstreetmap.fr

• Si apre una delle carte di insieme di OpenStreetMaps
• Accedere utilizzando le credenziali OpenStreetMaps (o

anche Twitter, Bitbucket o Github, se le avete...)
• è anche possibile giocare senza credenziali, ma le

possibilità sono limitate

• A sinistra funzioni di controllo, a destra di editing

• Digitare a sinistra il tasto e cercare una città (Pisa)
• Se non piacciono alcuni nomi in francese, scegliere

un’altra mappa di sfondo
• premere a destra e selezionare "OpenStreetMaps"
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Aggiungere feature
• Potete inserire a piacere (tasti a destra)

• punti, linee, perimetri
• Selezionare con un click il simbolo desiderato e spostarsi

sulla mappa
• Un singolo click posiziona il punto
• Una serie di click per punti consecutivi di una linea o

perimetro
• Un doppio click per terminare la linea o chiudere un

perimetro
• Al termine della definizione della feature indicare

• il nome e la descrizione che appariranno in un pop-up
nella mappa

• per modificare nuovamente cliccare sul punto e selezionare
la matita

ATTENZIONE
• Per vedere i pop-up premere in alto a destra Disabilita la

modifica
• per ritornare in modalità Modifica premere la matita

nell’angolo in alto a destra
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Contenuti speciali nella descrizione
• una immagine, inserendo il link all’immagine tra due graffe:

{{http://www.example.com/fiore.jpg}}

• un link, inserendolo tra due quadre:

[[http://www.google.com]]

• una risorsa embedded, ad esempio un video youtube, tra
tre graffe:

{{{http://www.youtube.com/n4IhCSMkADc}}}

• Per altre possibilità premere il piccolo punto interrogativo in
testa al riquadro descrizione
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Condivisione e download

• Per controllare l’accessibilità della mappa premere , a
destra

• Attenzione: accesso molto lento
• Consentire ad altri (o a tutti) di modificare la mappa
• Consentire ad altri di vedere (condividere) la mappa

• Premere a sinistra
• Istruzioni per l’embedding della mappa in una pagina Web (

iframe...)
• Url corta per semplicità (provatela sullo smartphone)
• Download delle vostre feature con vari formati

• Provate a scaricare ed osservare il formato geojson
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Conclusioni

• La cartografia digitale in questo momento è utilizzata al di
sotto delle proprie possibilità

• siamo ancora fortemente condizionati dall’uso classico
della cartografia

• Abbiamo visto come la cartografia digitale immerga il
mondo reale nel web

• collegando oggetti reali a risorse web e viceversa

• E’ un percorso solo all’inizio, che va controllato per venire
incontro ai nostri bisogni

• Uno studio che trova il suo posto nel corso di Informatica
Umanistica...
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Time for a uMap challenge
Step 1: geolocalizziamoci

• Inserisci una feature punto in corrispondenza della tua
provenienza nella mappa http://u.osmfr.org/m/151488.
Quello che vuoi: residenza anagrafica, domicilio, nascita,
dove stai meglio ecc.. Metti un tuo nickname nella
descrizione del punto.

Step 2: la mappa per la Torre
• Inviti un amico a vedere la Torre: lui arriva in treno alla

stazione. Crea una mappa che illustri il percorso a piedi
fino alla fermata dell’autobus, poi quello in autobus, e dalla
fermata di discesa sino alla Torre. In corrispondenza alla
fermata di salita sull’autobus inserisci una descrizione che
indichi numero e direzione dell’autobus, alla fermata di
discesa il nome della fermata e il tempo di percorrenza
stimato. Puoi usare autolinee di fantasia. Per finire
inserisci la URL breve nella descrizione del punto dello
step precedente.

http://u.osmfr.org/m/151488/

